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Get to know S32K118-EVB

CAN Communication Bus | [ LIN Communication Bus

OpenSDA USB
SBC UJA1169

External Power Supply (5-12V)

OpenSDA MCU

Reset Button

Transceiver TJA1027T
OpenSDA JTAG

J2 Header

J3 Header

¥900-9A3BT 1 4EES

S32K118 MCU
J1 Header

J4 Header
J14 SWD connector.

Touch electrodes
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RGB LED Potentiometer
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S32K118 EVB Features:

» Supports 64LQFP and 48LQFP packages
* Small form factor size 4.5” x 2.3”
* Arduino™ UNO footprint-compatible with expansion “shield” support

» Integrated open-standard serial and debug adapter (OpenSDA) with
support for several industry-standard debug interfaces

« Easy access to the MCU 1I/O header pins for prototyping

« On-chip connectivity for CAN, LIN, UART/SCI.

« SBC UJA1169 and LIN phy TJA1027

» Potentiometer for precise voltage and analog measurement

« RGBLED

« Two push-button switches (SW2 and SW3) and two touch electrodes

* Flexible power supply options
* microUSB
« external 12V power supply

\r
4\
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Header/Pinout Mapping for S32K118

EBl e | porr | runcrion |
- 12 m PORT FUNCTION

13-02  PTBO GPIO 13-01 VBAT
J3-04  PTBL GPIO 13-03 ) VDD_PERH 12-01 PTC2 FTMO_CH2
13-06  PTB6 GPIO 1305 PTAS RESET 19-02 pe— FTMO CH3
1308 PTB7 GPIO 13-07 ; 3.3v =
1310 PTE4 GPIO 13-09 - 5V - 12-03 PTBS LPSPI0_PCS
13-12  PTES GPIO J3-11 : GND r 12-04 PTB4 LPSPI0_SOUT
13-14 PTA11 GPIO J3-13 - GND : J2-05 PTB3 LPSPIO_SIN
1316  PTB12 GPIO 1315 - VBAT - : 12-06 PTB2 LPSPI0_SCK
L r J2-07 - GND
J3 E - 12-08 - AREF
: : J2-09 PTA1 LPI12C0O_SDA
r J2-10 PTAO LPI12C0_SCL
r

J4
Bl e porr | runcriov
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J4-02 PTC6 GPIO J4-01 PTA6 ADCO_SE2 i Eig 07 : 5 = J1-02 PTE10 GPIO J1-01 PTA2 LPUARTO_RX
14-04 PTC7 GPIO J4-03 PTCO ADCO_SE8 ; { J1-04 PTE11 GPIO J1-03 PTA3 LPUARTO_TX
J4-06 PTC8 GPIO J4-05 PTC1 ADCO_SE9 J1-06 PTEO GPIO J1-05 PTA13 FTM1_CH7
14-08 PTC9 GPIO J4-07 PTC14 ADCO_SE12 J1-08 PTE1 GPIO J1-07 PTA12 FTM1_CH6
J4-10 PTD4 GPIO J4-09 PTC15 ADCO_SE13 J1-10 PTE6 GPIO J1-09 PTDO FTMO_CH2
J4-12 PTD15 GPIO J4-11 PTC16 ADCO_SE14 J1-12 PTE7 GPIO J1-11 PTD1 FTMO_CH3
J4-14 PTD16 GPIO J4-13 PTC17 ADCO_SE15 J1-14 PTD3 GPIO J1-13 PTD2 FXIO_D4
J4-16 PTE8 GPIO J4-15 PTB13 GPIO J1-16 PTD5 GPIO J1-15 PTES FTMO_CH7

4  EXTERNAL USE ™ Arduino compatible pins
~ NXP pins *0ohm resistor is not connected



Jumper Settings Note: The resistances below
are populated in RevB

Configuration

J104 1-2 Reset signal to OpenSDA, use to enter into OpenSDA R754
Bootloader mode

R755
2-3 (Default) Reset signal direct to the MCU, use to reset S32K118. R756
J107 1-2 (Default) S32K118 powered by 12V power source. R757
S32K118 powered by USB micro connector. R758
2-3
J10 2-3 (Default) MCU voltage 5v R754 0402 DNP // PTBO
R755, 0403 DNP > PTA1
R756,0403"  DNP > PTAO
1-2 MCU voltage 3.3v _R757, 703" \DNP 0 PTBA
_ R758, 0403 . DNP > PTA11
J108 1-2 (Default) Select LIN master option - \
J15 1-2 (Default) Used for current measurement
A 4
5 EXTERNAL USE 4\



HMI mapping

6 EXTERNAL USE

Component__|saakite

Red LED

Blue LED

Green LED
Potentiometer

Sw2

SW3

OpenSDA UART TX
OpenSDA UART RX
CANTX

CAN RX

LIN TX

LIN RX

SBC_SCK
SBC_MISO
SBC_MOSI
SBC_CS

PTD16 (FTMO CH1)
PTES (FTMO CHS)
PTD15 (FTMO CHO)
PTA7 (ADCO_SE3)
PTD3

PTD5
PTB1(LPUARTO_TX)
PTBO(LPUARTO_RX)
PTE5(CANO_TX)
PTE4 (CANO_RX)
PTC7(LPUART1_TX)
PTC6 (LPUART1_RX)
PTB2 (LPSPIO_SCK)
PTB3(LPSPIO_SIN)
PTB4(LPSPI0_SOUT)
PTB5(LPSPIO_PCS1)
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S532K118 EVB
OUT OF THE BOX




Step 1: Power up the Board — EVB Power Supplies

- The S32K118-EVB evaluation board powers from a USB
or external 12V power supply. By default 12V power is
enabled with J107 (check slide 5)

- Connect the USB cable to a PC using supplied USB

cable . _:

- Connect other end of USB cable (microUSB) to mini-B
port on S32K118-EVB at J7

- Allow the PC to automatically configure the USB drivers if
needed

- Debug is done using OpenSDA through J7

8 EXTERNAL USE x



Step 2: Power up the Board — Is it powered on correctly?

- When powered through USB, LEDs D2 and D3 should light green

- Once the board is recognized, it should appear as a mass storage
device in your PC with the name S32K118EVB.

~ Devices and drives (2]

0 OsDisk () 532K118EVE (D)
(T
L 4 |
-y 63.7 GB free of 237 GB Ty 127 ME free of 127 MEB
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Step 3: Power up the Board — Is it powered on correctly?

$32K118EVB-Q064

- Board is preloaded with a software, in
which the red, blue and green leds will
toggle at different rates.

0 Roigi 755 50
st &g 2%
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S32K118 JUMPSTART
EXPERIENCE
BASED ON THE
FREEMASTER TOOL




Install the FreeMASTER tool

= Download and install the FreeMASTER PC application www.nxp.com/FreeMASTER .
= Open the FreeMASTER application on your PC. You should see Welcome page:

File Edit View Explorer Project Tools Help
FH@E SSs e Bl ooh e oy

e ot

Welcome to FreeMASTER

« What's New in Version 2.0?
See description of the most important changes and improvements implemented in this
application version. Connection Wizard, Active Content and graphics fetched from
target memory, improved GUI and more!

« Visit FreeMASTER home page
Visit the application home page at www. freescale.com.

« Get MCU Communication Drivers
The latest version of FreeMASTER drivers for UART, LPUART, FlexCAN, msCAN and
ather intarfaces is available for download at the official download page. The driver
documentation is available here.

Create New Project
« Connection Wizard NEW!

Connect to your board in few easy steps. This Wizard will help you to select
communication port or set up a BDM parameters to connect to your Freescale
microcontrolier board.

« Continue with this Project
Hide the welcome message and start by working with this empty project. You can
disable the welcome message for subsequent starts in the Option Settings dialog
(here)

« Open an Existing Project...
Browse your disk folders and find the project file you want to open in the FreeMASTER
environment.

More Reading
« Users Manual

Open the application manual in PDF format.

« Protocol Specification
Open the HTML Help document describing the FreeMASTER communication protocol

and host-side library. -
weizora sersar
Vanable Watch v QX

Name Value Unit Period
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Power up the EVB board

13

Powers the S32K118EVB evaluation board from a
USB. By default, the USB power is enabled by JO7
jumper.

Connect the USB cable to a PC and connect micro
USB connector of the USB cable to micro-B port J7
on the S32K118EVB.

Allow the PC to automatically configure the USB
drivers if needed.

When EVB is powered from USB, LEDs D2 and D3
should light green.

The EVB board is preloaded with a software
toggling the RGB LED colors periodically between
RED-GREEN-BLUE.

EXTERNAL USE

532K118EVB-Q064 | ,F




Setup serial connection in the FreeMASTER tool

Setup communication port to “OpenSDA"™ and speed to 115200 b/s:

Comm | MAP Files | Pack Dir| HTML Pages | Demo Mode | Views & Bars |

— Communication
™ Setup Communication manualy: w RS232.  Port Iopensda LI IOpenSDA-CDCSerialF’ort[http:fhvmv.perr
@ . . " Speed: |1152{}{] vl Timeouts... |
Go to: “Project > Options > Comm p

" Plug-in Module: I ll
Connect string: Idrv=4;ptype=3;pnum='l;devid=F‘E5EI‘|‘IESD;devILI Configure. . |
[T Save settings to projectfile [w Save settings to registry. use it as default

OR

© File Edit .l plorer Project | Tools | Help
= Setup communication automatically: | 2H@®= «u o « Cornesion Wil CHEAEX 2-d,
Go to “Tools > Connection Wizard® || S Record Trastr.
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The FreeMASTER JumpStart project is loaded

15

E 532K118_EVB_JumpStart - FreeMASTER

© File Edit View Explorer Project Tools Help

: o I [ Be B S = = BB > |0 o o 0 T[] 4 8 L K2, [Taomo P Y Y

Pins of the J2 and J1 connectors are configured as outputs.

= - (] 000
==~ 100000 0000 -000

. CONNECTOR T2 /"/'/ CONNECTOR 'T1" ,—"'

&

Green Blue

(OO0

- LAY -
e CONNECTOR T3 \\ v, CONNECTOR'I4 ha

b | ) s el | s .. e .. e ..
naj|naj|naj|naj|naj|naj|na naj|na ......

Pins of the J3 and J4 connectors are configured as inputs.

<

S32K1xx Web Links:

== 532K Overview

== S32K 118 Evaluation Board:
= Getting Started
> S32K118EVB Quick Start Guide
> S32K118EVB-Q064 Schematic
> S32K1xx Fact Sheet
> S32K1xx Data Sheet
> S32K1xx Reference Manual

= §32K1xx Product Brief
== SW Tools:

= FreeMASTER Run-Time Debugging Tool
> 532 Design Studio IDE

== 532K 118 JumpStart Sources:
= S$32K118 EVB JumpStart PC Host Project

= S32K118 EVB JumpStart Firmware

contral page

Ready

EXTERNAL USE
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The FreeMASTER JumpsStart project description

Pins of the J2 and J1 connectors are configured as outputs. By
single click on each pin you can change their logical level to log0
or log1. User can connect e.g. LED diodes to these ouput pins. TPUCh Sense Electrodes

!

| \ Potentiometer

onjedtors are configured as outputs. S32K1xx Web Links:

na) e == §32K Overview
na na na V- i

CONNECTOR T2 ’,-’/// CONNECTOR 'T1'

== $32K118 Evaluation Board:
> Getting Started
> S32K118EVB Quick Start Guide
> S32K118EVB-Q064 Schematic
> 832K 1xx Fact Sheet
> 832K 1xx Data Sheet
> 832K 1xx Reference Manual

..... . 3 n > 532K 1xx Product Brief
& i == SW Tools:

= $32 Design Studio IDE

L s
; \ “\ CONNECTOR T4 Lo == 532K 118 JumpStart Sources:
na na na na na na na na na LED

Pins of the J3 and J4 connectors are configuied as inputs.

3
\
CONNECTOR 13

Fes
-

> S32K 118 EVB JumpStart Firmware

—> Mechanical
\ i Buttons
I
Pins of the J3 and J4 connectors are configured as inputs.
Logical level (log0/log1) is visualised for all connector pins.

User can connect e.g. push-button keyboard to these input pins.
16 EXTERNAL USE

= FreeMASTER Run-Time Debugging Tool

> $32K 118 EVB JumpStart PC Host Project

Links to S32K1xx docs:
= Fact Sheet
= Data Sheet
= Reference Manual
* Product Brief
= S32K116EVB Quick Start Guide
{_ Tools:
* FreeMASTER
= S32 Design Studio IDE
= S32K116EVB JumpStart source
files

—



The FreeMASTER JumpsStart oscilloscope feature examples

View | Explorer Project Tools Help

= Display main project panel “View > Project Tree". [l e Tee

Variable Watch Ctrl+E
Application Commands Ctrl+3
Variable Stimulus Ctrl+C
Show Control Page as a Bar Ctrl+R

All App. Commands Visible
View Toolbar

View Variable Watch Toolbar

View Status Line

Application Layout »

= Display real-time oscilloscope graph examples such as ,Potentiometer” or ,Touch Sense Electrodes”.
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Analog values from potentiometer. Responses from touch sense electrodes.
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INTRODUCTION TO
OPENSDA



Introduction to OpenSDA: 1 of 2

OpenSDA is an open-standard serial and debug adapter. It bridges serial and debug communications between a USB host and an
embedded target processor. OpenSDA software includes a flash-resident USB mass-storage device (MSD) bootloader and a
collection of OpenSDA Applications. S32K118 EVB comes with the MSD Flash Programmer OpenSDA Application preinstalled.
Follow these instructions to run the OpenSDA Bootloader and update or change the installed OpenSDA Application.

Unplug the USB cable if attached
Set J104 on position 1-2.
Press and hold the Reset button (SW5)

Plug in a USB cable (not included) between a
USB host and the OpenSDA USB connector
(labeled “SDA”)

5. Release the Reset button

N~

A removable drive should now be visible in the host
file system with a volume label of BOOTLOADER.
You are now in OpenSDA Bootloader mode.

IMPORTANT NOTE: Follow the “Load an OpenSDA
Application” instructions to update the MSD Flash
Programmer on your S32K118 EVB to the latest
version.

19  EXTERNAL USE

1. While in OpenSDA Bootloader mode, double-click
SDA_INFO.HTML in the BOOTLOADER drive. A web
browser will open the OpenSDA homepage containing the
name and version of the installed Application. This
information can also be read as text directly from
SDA_INFO.HTML

2. Locate the OpenSDA Applications
3. Copy & paste or drag & drop the MSD Flash Programmer
Application to the BOOTLOADER drive

4. Unplug the USB cable and plug it in again. The new
OpenSDA Application should now be running and a
S32K118 EVB drive should be visible in the host file system

You are now running the latest version of the MSD Flash
Programmer. Use this same procedure to load other OpenSDA
Applications.

h
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Introduction to OpenSDA: 2 of 2

The MSD Flash Programmer is a composite USB application that provides a virtual serial port and an easy and convenient way to
program applications into the S32K118 MCU. It emulates a FAT file system, appearing as a removable drive in the host file system with
a volume label of S32K118EVB. Raw binary and Motorola S-record files that are copied to the drive are programmed directly into the
flash of the S32K118 and executed automatically. The virtual serial port enumerates as a standard serial port device that can be opened

20

with standard serial terminal applications.

Using the MSD Flash Programmer

1. Locate the .srec file of your project, file is under the
Debug folder of the S32DS project.

2. Copy & paste or drag & drop one of the .srec files to
the S32K118EVB drive

The new application should now be running on the
S32K118 EVB. Starting with v1.03 of the MSD Flash
Programmer, you can program repeatedly without the
need to unplug and reattach the USB cable before
reprogramming.

Drag one of the .srec code for the S32K118 EVB board
over USB to reprogram the preloaded code example to
another example.

NOTE: Flash programming with the MSD Flash Programmer is

currently only supported on Windows operating systems.

However, the virtual serial port has been successfully tested on

Windows, Linux and Mac operating systems.

EXTERNAL USE

1. Determine the symbolic name assigned to the S32K118EVB
virtual serial port. In Windows open Device Manager and look
for the COM port named “PEMicro/Freescale — CDC Serial
Port”.

2. Open the serial terminal emulation program of your choice.
Examples for Windows include Tera Term, PuTTY, and
HyperTerminal

3. Press and release the Reset button (SW5) at anytime to
restart the example application. Resetting the embedded
application will not affect the connection of the virtual serial
port to the terminal program.

4. ltis possible to debug and communicate with the serial port
at the same time, no need to stop the debug.

NOTE: Referto the OpenSDA User’s Guide for a description of a known
Windows issue when disconnecting a virtual serial port while the COM
port is in use.
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INSTALLING S32DS



Download S32DS

Download S32DS from:

S32DS for ARM

22  EXTERNAL USE



CREATE A NEW
PROJECT IN S32
DESIGN STUDIO




Create New Project: First Time — Select a Workspace

- Start program: Click on “S32 Design Studio for ARM v2.0” icon
- Select workspace:
- Choose default (see below example) or specify new one

- Suggestion: Uncheck the box “Use this as the default and do not ask again”
- Click OK

i !
= Eclipse Launcher u

Select a directory as workspace

532 Design Studio for ARM uses the workspace directory to store its preferences and development artifacts.

‘Workspace: C\Users\B523 21 \workspace - Browse...

[] Use this as the default and do not ask again

» Recent Workspaces

[ ok || Cconcel
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Create New Project: Top Menu Selection

- File — New —Project

+ workspace - C/C++ - 5

File | Edit Source Refactor Mavigate Search Project Run  Processor Expert Window Help

25 EXTERNAL USE

L= = 2 Quick Access i3 |:ﬁp
= 8 0= Outline 82 (@ Build Targets = 08
b=

An outline is not available.

BpEER mBE~g-= A8

New Alt+5hift+MN » |_::’ 532D5 Application Project
Open File... = 53205 Library Project lication Project
(4 Open Projects from File System... i s32D5 Project from Example
Close Crl+W Makeefile Project with Existing Code
Close All Ctrl+Shift+W C++ Project
. -
Save Ctrl+S C Project
. .
Save As... C/C++ PrOJ.ECt. .
Save All CtrleShift+S ; 532D5 Application Project
Revert == 53205 Library Project
™ Project...
Move... .
Rename... B2 Convert to a C/C++ Project (Adds C/C++ Mature)
Refresh Es a%  Source Folder
Convert Line Delimiters To 3 [ Folder
|£|<> Source File
DT il @} Header File
Switch Workspace » | [ File from Template
Restart & Class
Lxg Import.. ™ Example...
i Beport.. =9 Other. Ctrl+ M
Properties Alt+Enter
1 main.c [532K144_Rev2 EVE_CAMN_FD_LCD...]
2 led_funch [532K144 Rev2 EVB_CAM_FD..]
Exit J Console 51 Properties [§} Debugger Console
~ Settings FreeRTQS Task Aware Debugger Console



Create New Project: S32DS Project

26

- Project Name:
- Example: FirstProject
- Project Type:

- Select from inside
executable or library folder

« Next

EXTERNAL USE

*= MNew 532D5 Application Project

Create a 532 Design Studio Project

53205 Application Project

=

E—

Project name:

| FirstProject

Use default location
Location: | C\Users\nxa1268%\workspace532DS.ARM\FirstProject Browse...

Processors: ToolChain Selection:

type filter text Core Kind MName Toolchain
Standard 53205 toolchain for ARM

> (== Family KEA MOplus Cortex-M0+

v [= Family 532K T
i 532K144
B s32K142
B s32K148
H s32Kn118

B S32K146
B S32K116 Description :

5 = Family MAC57D 5 GCC toolchain is selected
» = Family 532V

©) - Conce




Create New Project: S32DS Project

- Select Debugger Support and Library Support
- Click Finish

= New 53205 Application Project

New 532DS Project for 532K118

Select required cores and parameters for them.

Project Name FirstProject

Core Cortex-MO+
Library EWL

1/0 Support MNo /O

FPU Support Toolchain Default
Language z

SDKs

Debugger PE Micro GDB server

27  EXTERNAL USE
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OpenSDA Configuration

- To Debug your project with OpenSDA, it is necessary to select the OpenSDA in the
Debug Configuration.

- Select your project, and click on debug configuration

* workspace532D5.ARM - C/C++ - FirstProject/src/main.c - 532 Design Studio for ARM

- x
File Edit Source Refactor Mavigate Search Project Run ProcessorExpet Window Help

Hmild | B-&-BiFICiE NS S F-B-E- G-t -0~ USSP B IRE TR AR R [ouickAccess] §| 9 | [ 4%
7 Project Explorer 33 BE ¥ = 0 [manc (no launch history) —

~ (25 FirstProject: Debug ~ ® * main implementati Debug As >

¥ Includes Debug Configurations...
(3 Project Seftings #include "S32K118.h" Organize Favorites... ions
2 include
3 src = int main(void)
{
#define COUNTER_LIMIT 180
int counter = ;
for(;) {
counter++;
if{counter > COUNTER_LIMIT) {
counter = 9
H
}
/* to avoid the warning message for GHS and IAR: statement is unreachable*/
#if defined (_ghs_)
#pragma ghs nowarning 111
sendif
#if defined (_ ICCARM_)
#pragna diag suppress=Pelll
#endif
return 8;
}
v
5. Components - FirstProject 52 E ¥=0

Problems asks  [E) Console %

28  EXTERNAL USE R

0 items selected

all Hierarch %.Eﬁ;“"'a'sﬁ":'ﬁ
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OpenSDA Configuration
- Select the Debug configuration under GDB PEMicro Interface Debugging

- Click on Debugger tab

« Debug Ceonfigurations

Create, manage, and run configurations

x| = - Name: FirstProject_Debug

M5 Debugg=i

[] Common | 85 OS5 Awareness |

o
type filter text

[€] C/C++ Application Project:
[E] C/C++ Remote Application -
[c] GDB Hardware Debugging FirstProject
4 [ GDB PEMicro Interface Debugg "
Specify the number of additional ELF Files you wish to program: 0 |Generate ELF Fields

B FirstProject_Debug
B FirstProject_Debug_RAM
[ FirstProject_Release
[ ] GDB SEGGER J-Link Debugging
B Launch Group

C/C++ Application:

Debug/FirstProject.elf
[ variables... | [searchProject...| [ Browse.. |
Build (if required) before launching
Build Configuration: [[Debug -]
Enable auto build Disable auto build
Use workspace settings Configure Workspace Settings...
< W »
Revert Apply
Filter matched 8 of 11 iterms 2
[ Debug ][ clese

@
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OpenSDA Configuration

- Select OpenSDA as the interface, if your board is plugged should appear in the
Port field.

- Click Apply and debug to finish.

* Debug Configurations x
Create, ., and run config
(¥ Plugin has not been registered. Some functicnality may not be available.
= 1
L x ‘ B MName: | FirstProject_Debug
type filter test Main | %5 Debugger = Startup} B Source} =) Qommon} 85 s Awareness]
[©] €/C++ Application Software Registration "
C/C++ Remote Applicati
[€] C/C++ Remote Application . Please register your software to remove this message.
[©] GDB Hardware Debugging l g
v E GDE PEMicro Interface Debugging &= | Register now
E FirstProject_Debug
E FirstProject_Debug_RAM PEMicro Interface Settings
(& FirstProject Release Interface: USB Multilink. USB Multilink FX, Embedded OSBDM/OSITAG - USB Port
[€] GDB SEGGER J-Link Debugging
= Launch Group Port: USB1 - Multilink Universal Rev C (PEMBDDV1E) resh
Select Device Vendor: NXP Target: 532K118F256M4
Core: MO ~
Specify IP Specify Network
Additional Optiens
[] Emergency Kinetis Device Recovery by Full Chip Erase Use SWD protocol
Advanced Options
Hardware Interface Power Control (Voltage --> Power-Out Jack]
[ Provide power to target Regulator Output Voltage Power Down Delay ms
[l Pruseer nff tarnet unan snfhaare et U D Lin Mal 1000 hd
Revert Appl
Filter matched 9 of 25 items — BoY
@ \ |
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DEBUG BASICS




32

Debug configuration is only required once. Subsequent starting of debugger does
not require those steps.

Three options to start debugger:
- If the “Debug Configuration” has not been closed, click on “Debug” button on bottom right
- Select Run — Debug (or hit F11) e T e vee

&, Debug % F11
| [e] Fl @ profile

Note: This method currently selects the desktop target (project.elf) and gives an error. Do
not use until this is changed.

- Recommended Method: Click on pull down arrow for bug icon and select ... _debug.elf
target

Help

i R R -2
[E] 1 FirstProject_Debug_PME |
P Juse €

Debug As

Debug Configurations...
Organize Favorites
=

= o— dpt main(wvoid)

h
P
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Debug Basics: Step, Run, Suspend, Resume

tor Mavigate Search Project
Step Into (F5) e
[Step Into (75) |

Ste p OVG r ( F6) Cutzr uuNz:ig::e-%-Sean‘:r: iProjec‘t. ‘ ;1.,

Step Return (F7) e e

ictor MNavigate Search Project Run Window Help
° Run O (0 W3 2o @ L i = oanids - I g o=

Run FirstProject.elf

tor Mavigate Search

Suspend o e

ctor Mavigate Search

[@L‘?uu [ i S

eeeee

Resume (F8)
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Debug Basics: View & Alter Variables

- View variables in “Variables” tab.
- Click on a value to allow typing in a different value.

0= Variables 2 | 9 Breakpoints i Registers = Modules .
Mame Type

| eo: counter
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Debug Basics: View & Alter Registers

- View CPU registers in the “Registers” tab

- Click on a value to allow typing in a different value
- View peripheral registers in the EmbSys Registers tab = vaiaies « srcasome i regiers = 1w modures

Name Value
4 ¥ General Registers
W& ro 3
AT rl =1
r2 5326866944
a1 r3 a8
1010

s e e L= B L e (. ol |
" Expressions (%)= Wariables ©g Breakpoints 7. Peripherals =i, Modules | 7 EmbSys Registers 53 = OB
a Arch: cortex-m0 Vendor: Freescale Chip: SKEAF1284 Board: --- none ---
Register Hex Bin FReset Access  Address Description ar
a = IRQ Interrupt

| a s5C 02400 00000000 0200 RwW 0240031000 Interrupt Pin Request Status and CGE|
E IRQMOD (bit 0} [aE] [i] ﬂ 0: IRQ event is detected only on 1
E IRQIE (bit 1} [aE] [i] 'ﬂ’ Q: Interrupt request when IRQF s¢
E IRQACK (bit 2) 00 0 IRQ Acknowledge
E IRQF (bit 3} [3] Ju] & 0: Mo IRQ request
E IRQPE (bit 4) D0 4] GD:IRQ pin function is disabled.
E IRQEDG (bit 5) Oz [} & 0: IRQ is falling-edge or falling-e
E IRQPDD (bit 6) 00 0 & 0: IRQ pull device enabled if IRQF
E RESERVED (bit 7) [a50] [i] no description available i

Pt & P P R T [N PP TP T
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Debug Basics: View & Alter Memory

d Add Memory Monitor E) Console =] Tasks [® Problems #.) Executables | [J Memory 53

Monitors .:R K e
Ly

[ Add Memory Monitor l

= Monitor Memory d

- Select Base Address
to Start at : 0x20000000

Enter address or expression te moniter:

|0xaooomm v|

@ [ ok ]| cance |
o VleW Memory B Console ] Tasks [*] Problems 3 Executables [} Debugger Console (] Memory 32 D= Outline
Menitors = K S& ' 0x20000000 : 020000000 <Hex> 57 e Mew Renderings..n
@ (20000000 Address @ -3 4 -7 8 - B C-F

2e0ce000 [ELliial] ©0000000  0ROGEE0R  PEEOEEER
20000010 ©G000R02  QOOOOOOE  0POGGGEE  DPROOOOR
200PPA20 ©0G00OROR  QOOOOR00  00OGGEEE  PPPREEAR

36 EXTERNAL USE



Debug Basics: Breakpoints

Add Breakpoint: Point and Click
- light blue dot represents debugger breakpoint

[€] main.c &3

# * main implementation: use this 'C' sample to create your own application[]

#include "532K116.h™ /* include peripheral declarations 532K116 */

= int main(wvoid)
1

#define COUNTER_LIMIT lee
int counter = @;

for(;;) {
counter++;

if(counter > COUNTER_LIMIT) {
counter = 8;
¥
}
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Debug Basics: Reset & Terminate Debug Session

- Reset program counter

- Terminate Ctl+F2() e

[ Terminate (Ctrl+F2) ]
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CREATE A P&E DEBUG
CONFIGURATION
(OPTIONAL)



40

New P&E debug configuration

- Click in debug configurations

== workspace532DS.ARM - C/C++ - FirstProject/sre/main.c - 532 Design Studic for ARM

EXTERNAL USE

File Edit Source Refactor

Navigate Search Project Run

O-EHEl ®-&-@BiWFCiE

[ Project Explorer 52
~ [5 FirstProject: Debug
> G Includes
> (2 Project_Settings
> (2 include
>

(& src

5. Components - FirstProject &3

0 iterns selected

2% =0

v =g

Processor Expert Window  Help
-

Sitig-&E-E-@-

HO-Q-i® s

WEmiH oD

jte your own application[]

T (o launch history)
~ @ * main implementati Debug As >
#include "532K118.h" Organize Favorites...

© int main(void)
#define COUNTER_LIMIT 1@@
int counter = @;

for(s;) {

counter+t;

if(counter > COUNTER_LIMIT) {
counter = @;
}

}

/* to avoid the warning message for GHS and IAR: statement is unreachable™/

#if defined (_ghs_)
#pragma ghs nowarning 111
sendif

#if defined (_ ICCARM_ )
#pragma diag_suppress=Pelll
#endif

return 8;

}

2 Problems JZ] Tasks ‘B Console 52 [T Properties (53 Debug
FreeRTOS Task Aware Debugger Censole

ions 532K118 */

isassembly 12 Call Hierarchy

— X
=
= B8

R #E-8--0




New P&E debug configuration

- Create a new P&E launch configuration

Click on the debugger tab.

= Debug Configurations

Create, manage, and run configurations

= —+l,
ER9 | K Marme: | FirstProject

|t}fFIEﬁ|tEftE’¢ | Main . %5 Debuggea [ Startup] Ep Source] 5| Qommon] &5 os Awarenaﬂ
[T] C/C++ Application

o Broject:
[©] C/C++ Remote Application
[£] GDB Hardware Debugging | FirstProject | | Browse... |
v E GDB PEMicro Interface Debugging
Click to create a new E FirstProject Debug Specify the number of additional object files you wish to program: 1} | |Generate Object File Fields |
[£] GDB SEG(ER J-Link Debugging
P&E IaunCh = Launch Group

C/C++ Application:

DebughFirstProject.elf |
Variables... | | Search Project... | | Browse... |
Build (if required) before launching
Build Configuration: |5elect Automatically V|
(_) Enable auto build () Disable auto build
(®) Use workspace settings Configure Workspace Settings...
Revert Apply

Filter matched 7 of 1% items

® Debug | | Close
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New P&E debug configuration

42

 Select the device

#= Debug Configurations

Create, manage, and run configurations

1 /1, Plugin has not been registered. Some functionality may not be available.

CEX B3-

| type filter text

[©] C/C++ Application

[E] C/C++ Remote Application

[£] GDB Hardware Debugging

v E GDE PEMicro Interface Debugging

E FirstProject_Debug
[&] FirstProject_Debug_RAM
E FirstProject_Release

[£] GDB SEGGER J-Link Debugging

@ Launch Group

Filter matched 9 of 25 items

Select
device

MName: | FirstProject_Debug

Main | %% Debugger

Software Registration

Please register your software to remove t
A

PEMlicro Interface Settings

Interface: | USE Multilink, USE Multilink FX|

Port: |USB‘I - Multilink Universal Rev

Vendor: NXP F

Specify IP Specify]

Additienal Options
[]Emergency Kinetis Device Recovery by Full Ch

Advanced Options

Hardware Interface Power Control (Voltage --> P|

[IProvide power to target Regulatg

[ Boassar nff tarnet unnn cofhwars =it N

[ Startupj E_ySourc\'f_”“ .1 A5 A p 2

= Select Target Device

Allowed wildcard characters:
*=Match 0 or more characters, =Match exactly one character

| type filter text

v MNXP
> KEx
> MACSTD S
v 532K
S32K116F128M4

532K118F256M4

S32K144F512M15
S32K144F512M150NTTP
S32K146F 1MOMTT
S32K148F2MOMTT

5 532Viex

| Select I |

Cancel

)

I Debug | | Close

» Click Apply and debug your application
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USEFUL LINKS



« Cookbook application note. This application note contains a
bunch of simple examples of how to use different
peripherals.

o S32K1xx community. Visit this site for request support on
the S32K1xx products, you can also look for threads that
may contain the answer that you are looking for.
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SECURE CONNECTIONS
FOR A SMARTER WORLD




Looking for pricing, stock, or lifecycle information?

Click below to explore more details on WIN SOURCE:

© View [832K118EVB-Q064 on WIN SOURCE
© NXP/Nexperid Information

Optimize Your Supply Chain with WIN SOURCE Solutions

Global Sourcing Solution
Obsolete Management
Cost Control Management
Shortage Management
Alternative Solution

Excess Inventory Management


https://www.win-source.net/products/detail/nxp/s32k118evb-q064.html
https://www.win-source.net/manufacturer/nxp

